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In July of 2006, a young man named Terry (not his real name), a seventeen-
year-old student, was brought to the Lincoln County Adult Education Center
by his mother. She was hoping we could help Terry obtain his GED like we
had helped his older brother the year before. But unlike his brother, Terry
had serious learning disabilities and had been in Resource classes while in
public school. Terry was a very shy young man who would not look you in
the eye, wore a hat all the time, and spoke so softly when he talked that you
could not understand him.

When our students take the Tests of Adult Basic Education (TABE) and

their time is up, we mark where the student stopped and allow the student

to complete the test. This helps us determine if time is a factor in the score.
For those students who indicate they have learning disabilities, or if we
suspect they may have learning disabilities, we then administer the TABE

on tape. This gives us an initial indication of the students’ strengths and be-
gins the process of determining the effectiveness of various testing accommo-
dations. This is what we did with Terry.

On the written TABE test, Terry scored in the lowest scale score range on
each section. But when he was administered the TABE test on tape, he
scored in the higher scale score ranges on each section. It was the most
glaring example of an auditory learner | had ever seen. Terry could not read
simple instructions or write good simple sentences, because he spelled

what he heard. He was in a real dilemma. )
Continued on page 5

2007 tSL Sumumer Institute

Dr. Philip Less

The Arkansas Adult
Learning Resource
Center provides equal
access to all programs
and activities.

The Adult Education Section of the Arkansas Department of Workforce
Education provides not only financial and technical assistance for ESL
programs but also professional development for adult education instruc-
tors. For the last seven summers, ESL instructors from across the state
have converged for an intensive multi-day workshop to learn the most up-
to-date methods for teaching ESL students. This summer 50 teachers,
from Siloam Springs to DeQueen and from Monticello to Blytheville, met
from July 23rd to 26th at the Arkansas Adult Learning Resource Center in
Little Rock for the Seventh Annual ESL Summer Institute.

The ESL Institute focused on hands-on activities and strategies for teach-
ing. The trainer for this summer’s institute was Ms. Laurel Pollard, an
educational consultant from Tucson, Arizona. Ms. Pollard has written
four highly successful and practical books for ESL teachers: Zero Prep,
Zero Prep for Beginners, Now You're Talking, and Yours for the Asking.

Continued on page 8
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NOTICE:
When a workshop has a waiting list,
participants may not send substitutes
from their center to attend in their
place. Registrations are held for par-
ticipants and not for centers.
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http://www.escweb.net/ar esc/

Please remember that the AALRC is now
using ESC Web for all workshop/training
registrations. Tips, tricks, and hints may be

i If you are unable to attend a work-
found on the AALRC web site at:

shop for which you have registered,
please go online to ESC Web and
cancel your registration. Participants
are often placed on waiting lists be-
cause workshops fill up quickly. After
you cancel, ESC Web will send an
email to the first person in line on the
waiting list.

http://www.aalrc.org/profdev/ESCWeb.doc.

If you are still having trouble, you can al-
ways call the AALRC at 1-800-832-6242 or
1-501-907-2490.

Calendowr
AW eventy are at the AALRC wnless otherwise noted.

October 3 — Leadership Excellence Academy — Session 1 — ID: 61908

October 4 — GED Examiners’ Regional Meeting — Jonesboro Holiday Inn —
ID: 57108

October 8-10 — Literacy Task Analysis — ID: 60688

October 9 — GED Examiners’ Regional Meeting - Russellville — The Depot —
ID: 57107

October 11-12 — ESL Basics — Session 2 (Days 3-4)

October 17 — El/Civics - ID: 60698

October 17 — Office 2007 Overview - ID: 60643

October 18 — PowerPoint — ID: 60677

October 18-19 — Administrators’ Meeting - Little Rock Hilton

October 25-26 — AACAE Conference — North Little Rock Wyndham

November 5-6 — Literacy Tasks Analysis — Session 2 (Days 4-5)

November 8-9 — ESL Basics — Session 3 (Days 5-6)

November 13 — Beginning Excel — ID: 60678

November 14 — Movie Maker — ID: 60617

November 15-16 — Teaching With Manipulatives — ID: 60681

November 15-16 — Adult Education Advisory Council — Midsouth Community
College — West Memphis

November 21-23 — AALRC Closed

November 28 — Leadership Excellence Academy — Session 2

December 4-5 — Bridges out of Poverty/Applying Bridges — ID: 60695
December 7 — WAGE Council Meeting

December 19-January 2 — AALRC Closed
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Bridges Out of Poverty Seminar

The Bridges Out of Poverty Seminar is for any organization that works with people from poverty.
Only a deeper understanding of their challenges—and strengths—will help you partner with them
to create opportunities for success. Bridges Out of Poverty represents a powerful tool for change.
Based in part on Dr. Ruby Payne’s myth-shattering A Framework for Understanding Poverty,
Bridges reaches out to the millions of service providers and businesses whose daily work con-
nects them with the lives of people in poverty.

Bridges training contains case studies, detailed analysis, helpful charts and exercises, and specific
solutions you and your organization can implement right now to:

Redesign programs to better serve people in poverty;

Build skill sets for management to help guide employees;

Upgrade training for front-line staff like receptionists, case workers, and managers;

Improve treatment outcomes in health care and behavioral health care; and

« Increase the likelihood of moving from welfare to work.

The book Bridges Out of Poverty is used as a training manual in the seminars and includes chap-
ters on relationship building, mentoring, redesigning programs, and community collaboration.

Applying Bridges Concepts
Learn Strategies That Build Relationships and Improve Outcomes

This workshop is an extension of the Bridges Out of Poverty (Day One) seminar. The content of
the first day is typically extended into a second day to allow for more discussion and interaction. In
this workshop, participants will learn more about language experience, cognitive issues, and barri-
ers to change.

Participants will learn how to use mental models to communicate effectively, and to assist clients
from poverty to learn quickly, explore options, and develop future stories. Participants will also ex-
plore the skills of mediation, relationship building, and mentoring.

This workshop introduces strategies for changing program designs, policies, and procedures to
improve outcomes. Participants will use case studies and an examination of the client’s lifecycle to
identify principles of change. The presenter for this workshop will be Monica Bein from Owasso,
Oklahoma. Monica's Master's degree in speech pathology has led to international experiences.
She studied in France and worked in Bosnian and Romanian orphanages providing staff training
and therapy for children with special needs. She is often called upon to provide expertise for local
magazines, newspapers, and other news media. She collaborates with several community agen-
cies.

This two-day workshop is scheduled for December 4-5, 2007 at the Resource Center.

DONO6T FORGET TO REGI STER:

AR Association for Continuing and Adult Education  Adult Learning Rocks in AR

and Wyndham Riverfront Hotel
Arkansas Literacy Councils, Inc. North Little Rock
2007 Conference Registration October 25 & 26. 2007

For more information: http://aalrc.org/news/conferences.aspx
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News from the Disabilities Project Manager

Focus on Local Program Disabilities Training for FY 2007-08

The focus of the AALRC training regarding adults and disabilities this year is on workshops for local pro-
grams at their location. Workshops available for this more individualized approach include:

e Demystifying AD/HD (2 days; an overview of Attention-Deficit/Hyperactivity Disorder)

e Dondt Padayord tay;@n overview of Panic Disorder)

e Teaching Adults with Learning Disabilities for Adult Education Programs (2 non-consecutive days)
e Teaching Adults with Learning Disabilities for Literacy Programs (2 non-consecutive days)

For more detailed descriptions of these workshops, please go to
http://aalrc.org/resources/Id/ld_workshops.pdf

There are several reasons to offer these workshops via local format:

e Workshops will be tailored to fit the needs of each specific program;

e There are fewer participants per session than in a statewide training;

e Participants have more opportunities to relate new information to their specific program, instruction, and
students;

e Administrators are able to attend the local training with their staff, thus encouraging support and imple-
mentation of new knowledge;

e Participants have opportunities to brainstorm implementation strategies together as a program-wide
effort; and

e Specific program goals and objectives regarding implementation can be determined in the course of the
workshop.

For more information or to schedule a workshop for your program, please contact Patti White at
prwhite@madisoncounty.net or 800.569.3539.

Instructional Tips for Teaching Writing for Students with Learning Disabilities

Adults with learning disabilities sometimes have difficulty with writing assignments for a variety of reasons,
including problems expressing their thoughts in writing, coordination and fine motor skills, spelling, me-
chanics, and visual perception. There are a number of instructional strategies that may help — here are a
few that may be helpful for some students:

e Allow access to a keyboard for writing practice for students with fine motor difficulties.

e For practice with both writing and reading, encourage students to work in pairs at a keyboard. Tell
them to communicate with each other for five minutes without using any spoken language or body lan-
guage. This can reinforce the idea of both reading and writing as effective means of communication.

e Use Microsoft Word to create paper with rows to write on that has alternating white/color rows for writ-
ing. (Use the “insert table” function.) It looks like this:

e Use a spellchecker with auditory feedback, like the Franklin Language Master.
e Encourage the use of block fonts (sans serif) when the student is using a keyboard. Some good ones
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News from the Disabilities Project Manager

are Verdana, Arial, and Primer Print. There are also fonts available that are
written as dashed lines so the student can practice tracing the letters if you print
them out really big. There are a number of these fonts available for free at
http://desktoppub.about.com/od/fonts/p/schoolfree.htm.

o If the student is using Microsoft Word, here are a few things to remember:

e Arright-click on the mouse following a word will pull up a list of choices;
one is for synonyms. This is helpful for students with limited vocabular-
ies. There’s also a quick link to the thesaurus on that list.

e Go to http://support.microsoft.com/kb/306993/ for directions on install-
ing and using the “Language Bar,” a Microsoft tool that will read text out
loud, among other functions.

e Teach your student how to highlight the text for remembering phrases
or sentences they may want to revise later.

e Change the line spacing to double or more to reduce clutter.

e To further reduce clutter, change the spacing between words. (Click
“Edit,” then “Replace.” Type one space in the line by “Find what:” and
several spaces in the line by “Replace with:”. Then click “Replace All”.

e Use the “AutoCorrect” feature located in the “Tools” menu. This is an
extensive database of commonly misspelled and mistyped words and
abbreviations that will be replaced with the correct ones when typed.
You can add or delete from this list. Consider adding words the student
consistently has trouble spelling. (And no, this doesn’t help them spell
better, but it DOES allow them to practice writing fluently without so
many discouraging mistakes.)

e Increase the font size.

o Use a different background color while writing. (Click “Format,” then
“Background,” then choose the color you want.)

o Use the “Auto Text” function in the “Insert” menu to reduce keystrokes
and speed up the writing process.

e Switch to “Outline” view under the “View” menu to help students organ-
ize their writing more quickly.

e Encourage the student to add graphics to their text. Google Images has mil-
lions you can search with a key word at www.google.com/images.

e Use visual mapping software like “Inspiration™” to quickly brainstorm, organ-
ize, add graphics or videos, color-code, etc. for a pre-writing activity. Watch
the AALRC website for the next available “Inspiration” training.

Accommodations Do-WorkA!

Continued from page 1
7 7 (o4

The good news was we now knew what Terry needed. The challenge was meeting
his needs with only one full-time teacher in the classroom. We were able to secure
the books on tape from the AALRC which allowed Terry to work in the classroom.
The more successful Terry became in the classroom, the more he began to blos-
som. He began to open up to us and the other students in the classroom. He be-
gan to look us in the eye when he spoke to us and to speak up when he had some-
thing to say. We were able to secure the accommodations needed for Terry to
take the GED test on tape. Terry received his GED and is now employed.

Thank you to Klaus Neu, Patti White, Janice Hanlon, and to the instructor and
paraprofessionals who worked with Terry for all their help. Believe me: Accommo-

dations do work!!!
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New Associate Professor of Adult Education at
University of Arkansas in Little Rock

Dr. Carrie Boden was recently appointed Associate Professor of Adult Education
and Coordinator of the Adult Education Graduate Program at the University of Ar-
kansas at Little Rock. Dr. Boden replaces Dr. Charlotte Robertson, who retired in
July of this year. “I have big shoes to fill. Charlotte is beloved; she is so well-
known throughout the state and is excellent in all that she does,” Boden said.

Dr. Boden comes to the University of Arkansas at Little
Rock from Friends University in Wichita, Kansas, where
she has worked extensively with adult students. In her role
as Associate Professor, she taught writing, humanities,
literature, education, and English as a Second Language
courses. Over her nine years at Friends, Boden’s adminis-
trative assignments included serving as director of the Pro-
gram for Adult College Education, coordinator of English
and Languages for the College of Adult and Professional
Studies, and coordinator of the university-wide General
Education Program. For the past five years, Boden co-
coordinated a Sister Cities International exchange be-
tween Friends University and La Universidad La Salle in
Cancun, México.

Dr. Carrie Boden

As a researcher, Dr. Boden’s focus has been on adult learners, specifically on the
connections between personal beliefs and how well students learn. Most recently,
she has presented her findings at national and international conferences in Mil-
waukee, Wisconsin; Montego Bay, Jamaica; Granada, Spain; Havana, Cuba; and
Detroit, Michigan. Her publications include articles in The International Journal of
Learning, book chapters in The Encyclopedia of Ethnic American Literature, and
text books such as The College of Adult and Professional Studies Companion
and The Search for Meaning in a Changing World: An Interdisciplinary Reader.

International adult education is one of Dr. Boden'’s interests, and her awards and
honors include The Sister Cities International Innovation Award for Technology
and Communication and a Fulbright-Hays Award for Project ECHO, for which she
traveled with a group of educators to Paraguay, Argentina, and Brazil. In 1995,
Dr. Boden served as a delegate at the Non-Government Organization Forum on
Women in Beijing, China.

Dr. Boden holds a Ph.D. in Education from Kansas State University in Manhattan,
Kansas; a M.F.A. in Creative Writing from Wichita State University in Wichita,
Kansas; and a B.A. in English Language and Literature from Bethel College in
North Newton, Kansas.

Dr. Boden plans to build on the existing strengths of the Adult Education Program
at UALR. “The adult education program at UALR is grounded in the larger adult
education field, and | like that. Until now, | have been focused on this very small
subset of adult education, adult higher education, but in this program | will be able
to focus on other important aspects of the field such as literacy and adult educa-
tion in corrections settings,” Boden said. “| have been welcomed into the commu-
nity, and this increases my excitement about being here and about the opportuni-
ties | will have to collaborate and build partnerships within and beyond UALR,”
Boden said.
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Tech === Talk

Note: To link to any web address (URL) in this newsletter, go the AALRC's home page at
http://aalrc.org, look up this newsletter, and then just click on the appropriate link.

Microsoft Office 2007 Cin * Microsofte
2.0ffice

Did you know that the AALRC has one free copy of Microsoft Office 2007 Enterprise ($679.99
retail) available for all of our centers? If your center has not received your free copy, please con-
tact Rob Pollan (rob@aalrc.org). Please note that Office 2007 will only run on Windows XP or
Windows Vista (one free copy per center only). You can also purchase Office 2007 through the
AALRC for $26 per copy.

There is also a free alternative to Microsoft Office called OpenOffice. Go to www.openoffice.org
and download the latest OpenOffice software. This is totally free and it can open files in Micro-
soft Office formats and save to Microsoft Office Formats. You can install OpenOffice on as many
computers as you want, but do not confuse this with Microsoft Office (see Microsoft license infor-
mation above).

Microsoft Software

We can purchase all Microsoft software at deep educational discounts. Please let us know if you
are interested. We are trying to get a large group purchase of Windows operating systems to-
gether so we can get a better discount.

Microsoft’s educational discount program works by using a number system that they assign to
each operating system, Windows XP is worth 1 point but server software is worth several points.
We need an additional 150 points to be able to get Windows XP and other operating systems for
a price of around $25 (excluding servers). So if you are wanting to upgrade to Windows XP,
Windows Vista, or are considering a server purchase, please let us know so we can make a
group purchase and receive the deeper discounts.

Windows Vista P’

Are you considering getting new computers anytime soon? If you are purchasing computers for
your lab, | highly recommend getting Windows XP instead of Vista because you will probably run
into compatibility problems with your educational software using Vista. Also, Vista has tight se-
curity - which is a good thing because it keeps bad people out of your computer, but it can create
issues when trying to install software or make system changes.

If you are set on purchasing Vista, make sure that all the programs you use are compatible with
Vista before making your purchase. When checking program compatibility on the manufacturers
website, be sure to check the version number closely because the software manufacturer may
have a version that is compatible with Vista, but that may not be the version you have and you
may have to pay for an upgrade. Vista seems to work fine for Office use; you will just have to be-
come accustomed to new ways of doing things, and as stated above - be sure to check out any
software compatibility issues before making your purchase.
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2007 ESL Swmumer Institute

Dr. Philip Less
Continued from page 1

The topics that were covered in this summer’s four- ~ =
day workshop included: effective interaction rou-
tines, student motivation and retention, building
classroom community, multi-level options, helping
students take charge of their own learning, learning
outside the classroom, working with low beginning
students, vocabulary and reading activities, and
stress reduction activities for teachers and stu-
dents. Ms. Pollard also shared many resources
with the participants, including Out and About by
Hemmert and Kappra, and sections from her new-
est book, Wow! Stories from Real Life, which she
co-authored with Dr. Natalie Hess, who was last

year's summer institute trainer. Group photo of the ESL Summer Institute 2007 class

For further information about the Adult Education ESL Summer Institute or teaching English as a
Second Language to adults, contact Dr. Philip Less at the Arkansas Department of Workforce
Education at 501-682-1970.

Aduwlt Educationw Sectionw Federal Review

The Division of Adult Education and Literacy, Office of Vocational Adult Education, visited the Arkansas
Adult Education Section to conduct a site review in August. Allison Hill, Chris Coro, and Bill Bivens from
Washington D.C. and Josephine Reed-Taylor from Georgia were team members.

The review included interviews of state staff members, AALRC staff members, WIA partners, and Literacy
Council and Adult Education Directors. Site visits were conducted at four local programs. The state office
will receive a written report from the team in 45 days. They take the information gathered in Arkansas back
to Washington and work with others there to verify the review. Once the report is sent to Arkansas, the
state office will have 45 days to respond.

The team gave commendations on the Professional Development offered through the AALRC, WIA Col-
laborations, and the Shared Youth Vision (AR Youth Development Council). Several findings were cited.
Of those, it was found that the Request for Proposal process needs to be revised and recomputed; ex-
penses concerning GED examiner training and the testing office cannot be paid with federal funds; the cur-
rent assessment policy does not meet NRS guidelines; time and effort sheets must be adjusted; EL Civics
must have a new funding competition; and the 2003 Adult Education Policy Manual needs to be updated.

Recommendations were also suggested:

EL Civics — Civics instruction (history, government, legal systems, etc.) should be equally bal-
anced with English Literacy instruction (life skills).

Program Reviews — Good to see that the recommendations from the last review were imple-
mented quickly. They could see the improvement.

MIS — Impressed with what AR has done with the system. However, dual enrollment is a con-
cern with counting students more than one time for state numbers. Staff needs to be cross-
trained to better assist the field.

The issues raised by the Federal team are already being addressed by the state office and will be dealt
with in a timely manner. The state office found this a great experience to share the great things being done
in Arkansas as well as see what needs to be improved.
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